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ر این مقاله با  ، د برای عشق و عاشقی هستند زمان بهترین عروسی ها  ایجاد خواهید کرد آنچه در پایان این مقاله
 !عروسی متفاوت و جذاب آشنا خواهیم شد نحوه ایجاد تصاویر 

 ها و تم های عروسی ایده 

می توانید همچنین  . شما  استفاده خواهیم کرد،  که در زیر نشان داده شده اند   یگانرایاستاک های  در این مقاله از  

 استفاده کنید.نیز شخصی از عکس های برای پروژه خود 

 

 
 

ممکن را انجام دهیم. در این سعی می کنیم بهترین کار    ،روسی ها زمان خاصی در زندگی افراد هستند از آنجا که ع

را به عنوان  رویایی کوهستانی  یک منظره    وخواهم کرد  سنتی تنظیم    های  عروسیبر اساس  را    ها  ، رنگ لباسپروژه

 پس زمینه در نظر می گیرم. 

با جستجوی  و بی نظیر برگزار کنند.  جدید  یروش ت دارند این رویداد بزرگ را بابسیاری از زوج های خلاق دوس

  Pinterest، در "برای عکس عروسی ایده های منحصر به فرد "کلمات کلیدی مانند "عکس های نامزدی خلاق" یا 

 . می توانید ایده های خوبی بگیرید  Googleیا 

 



 ستانی یک منظره کوه نحوه ایجاد -1

 1مرحله 

 پیکسل خواهند بود.   1424* 1920نهایی من ابعاد یک سند جدید ایجاد کنید. 

 Free را با استفاده از ابزارآن کنید. اندازه پیست را روی یک لایه جدید کپی و  ستانیتصویر منظره کوه

T)-Transform (Control    ایجاد کنیم.تنظیم کنید تا کمی کوچکتر شود. این به ما کمک می کند تا عمق بیشتری 

 ، تصویر را روی سند قرار دهید.مطابق تصویر زیر

 
 2مرحله 

 دهیم!می را ادامه منظره ساخت 



یک لایه جدید در زیر لایه   کوهستانی را رویاز منظره قسمت دیگری نیاز داریم. اکنون به قسمت پایین تصویر 

  Polygonal Lasso Tool (L)در این مرحله می توانید از یک ابزار انتخاب سریع مانند  کنید.پیست اول کپی و 

 استفاده کنید. 

  برای قرار دادن   (pathو هموار )   باریکیک مسیر    قسمت سمت چپ پایین را انتخاب کنید زیرا در این قسمت باید 

 ایجاد کنیم. عروس و داماد 

 
 

 3مرحله 

برای ایجاد یک مسیر به سمت مرکز تصویر   پایین راشنی کنید. قسمت  انتخاب قسمت دیگری از عکس اصلی را 

 انتخاب کنید.

 .بچسبانید   کپی کرده و روی یک لایه جدید در زیر کوهآن را 



 
را با   ها لایه ر اضافه کنید. لبه های تند و تیزبه لایه های کوه و مسیرا اکنون در صورت لزوم یک لایه ماسک 

 ( Opacity %100 و  Hardness %0گرد کنید. )، رنگ مشکی در ماسک با یک قلم نرم استفاده از 



 
 4مرحله 

آنها را حذف بهتر است  ، بنابراین  عکس را کمی شلوغ کرده اند آنها    های موجود در پس زمینه توجه کنید.  به اسب

 کنیم!

خواهیم کرد. برای   خاک استفاده  برای پوشاندن آنها با چمن وقسمت های دیگر منظره ، از اسب هاحذف برای 

سپس آن را کپی کرده و روی یک   انتخاب کنید  Lasso Tool (L)منطقه را با ابزاریک ، ابتدا باید انجام این کار

 لایه جدید در بالای لایه کوه قرار دهید. 

 از یک لایه ماسک استفاده کنید.برای از بین بردن لبه های ناصاف چمن را روی اسب قرار دهید تا مخفی شود.  



 
 .می بینید بدست آورید   را بپوشانید تا نتیجه ای شبیه به آنچه در زیرها اسب 

 ! ها خداحافظ اسب

 



 
 . شوند   را انتخاب کرده و راست کلیک کنید تا با هم ادغام منظره  تمام لایه های  



 
 5مرحله 

می  را اضافه زوج عمق بیشتری ایجاد کنیم. انجام این کار باعث می شود وقتی بعداً اجازه دهید در این قسمت 

 . کنیم، نگاهمان به آنها جلب شود

قسمتی از آسمان را انتخاب    Polygonal Lasso Tools (L)و    Magneticلایه کوه را انتخاب کنید. با استفاده از

 کنید.

 . شود  آسمان کمی تارپیکسل اضافه کنید تا   Radius 5، و یک  بروید  Filter >Blur  >Gaussian Blurسپس به  



 
 .افزایش دهید  ( را کمیblurتیرگی )

یک    بروید و  Filter  >Blur Gallery  >Shift-Tilt، به  اضافه کنید. با انتخاب لایه کوه  Tilt shift، یک تیرگی  سپس

 ایجاد کنید.مانند تصویر زیر  Tilt shiftجلوه  

Blur  و  پیکسل تنظیم کرده 15را رویOK  .کنید 

 

 

 



 
 . نحوه ایجاد لباس عروسی 2

 ! می پردازیم  جزئیات زوج و عروسیکمی به  منظره ،  روی بیشتر   اتتنظیماجام قبل از 

 

 1مرحله 

  زیرا در مرحله بعد ، نباشید لبه ها نگران را انتخاب کنید. زوج ،  Polygonal Lasso Tool (L)با استفاده از ابزار 

 آنها را اصلاح خواهیم کرد. 

. اندازه آنها را با استفاده از ابزار  پیست کنید  شده کپی و لایه جدید در بالای لایه کوه تارروی یک  زن و شوهر را

Free Transform (Control-T)  را در مرکز ترکیب قرار دهید. تنظیم کرده و آنها 



 
 

 2مرحله 

 لایه ماسک به لایه زوج اضافه کنید. یک  

برای رنگ آمیزی مشکی روی ماسک استفاده  (  Hardness  ،100٪Opacity٪ 100از یک برس سخت گرد ) 

 د. از بین بروند نوجود داردر تصویر کنید تا مناطق ناخواسته ای که 

 را نیز از بین ببرید!  ی آنهافراموش نکنید که فضای باز بین بازوها و پاها



 
 . حاصل شود زیرتصویر همچنان به اصلاح لبه ها ادامه دهید تا نتیجه ای مشابه  



 
 

 3مرحله 

 هستم! این کار  ! من عاشق های آنها بپردازیم اکنون زمان آن رسیده که به لباس

سنتی   های عروسیدر اینجا من از رنگ های ، اما دارند رنگ های عروسی در سراسر دنیا پالت های مختلفی 

 کت و شلوار مشکی برای داماد و پیراهن سفید برای عروس! ، استفاده می کنم



 
را نگه دارید تا  Shiftانتخاب کنید. سپس کلید  لباس عروس را Polygonal Lasso Tool (L)با استفاده از ابزار 

 رنگ آنها را نیز تغییر خواهیم داد.. ما انجام دهید  های بنفش در اطراف گل یک انتخاب دیگر

برای سفید شدن لباس عروس  بروید.  Layer >New Adjustment Layer >Hue and Saturationاکنون به 

  Clipping Mask. سپس بر روی آن راست کلیک کرده و آن را به عنوان  وارد کنید مقادیر نشان داده شده در زیر را  

 قرار دهید.  coupleدر لایه  

 : ( Hue and Saturation)  مقادیر رنگ و اشباع

 -19: (Hue) نگر

 -61: ( Saturation) اشباع

 -18: ( Lightness)روشنایی  

 

 4مرحله 

 .و آن را سیاه کنید  انجام دادهنیز داماد لباس همین کار را برای  

برای زوج تنظیم   Clippingرا به عنوان یک ماسک  Hue and Saturationجدید  Adjustmentدومین لایه 

 .را انتخاب کنید   د. قبل از اضافه کردن لایه تنظیم، حتماً لباس دامادکنی

 



 کنید:مقادیر را به شرح زیر تنظیم 

 0: (Hue) نگر

 - 100: (Saturation) اشباع

 -27: (Lightness)روشنایی  

 

 
 یی!زیبا زوج ! چه تا اینجای کار نتیجه به شکل زیر خواهد بود

مهمی مانند پوست یا مو   های کنید. قسمترا بیشتر ویرایش ماسک های لایه دار در صورت تمایل می توانید 

 دستکاری شوند.نباید 



 
 

 5مرحله 

 . زیرا ممکن است کمی بی روح به نظر برسند  می توانید تنظیمات بیشتری روی زوج انجام دهید 

 قرار دهید. Clipping Maskرا به عنوان    Curves جدید  Adjustment در لایه زوج یک لایه 

 تنظیم کنید.به شکل زیر کانال ها را  Blueو   RGB، منحنی های برای ارتقای کنتراست و رنگ

 ٪ کاهش دهید. 50را به    Opacityو    قرار داده   Hard Lightرا روی  منحنی ها     Layer Blend Modeحالت  سپس



 
 6مرحله 

داشته باشد. یک لایه تنظیم جدید  بیشتری  ، زن و شوهر را کمی تغییر می دهیم تا با منظره مطابقت  در مرحله بعد 

Color Lookup   را به عنوانClipping Mask لایه زن و شوهر تنظیم کنید. در 

 تنظیم کنید. FallColors.lookرا روی  DLUT3پرونده 



 
 7مرحله 

 کنیم. می ، رنگ پرتره را کمی تقویت عروس برویمسراغ تور قبل از اینکه 

 اضافه کنید. در بالای سایر لایه ها را   Color Lookupیک لایه تنظیم جدید از 

  Lighter Colorرا روی  Layer Blend Modeتنظیم کنید. سپس  Filmstock_50.3dlرا روی   DLUT3پرونده  

 ٪ کاهش دهید.68را به    Opacityتنظیم کرده و 



 
 8مرحله 

 ! اکنون به تور عروس می پردازیم

 استفاده خواهیم کرد.  Veil 2# و Veil 1#، از دو عکس ، تور برای طراحی

https://pixabay.com/en/wedding-couple-wedding-dress-veil-846924/
https://pixabay.com/en/marriage-bride-gown-dress-white-598314/


 
در  . آن را روی یک لایه جدید اولین تور را انتخاب کنید   Polygonal Lasso Tool (L)با استفاده از  .1

 Edit  >Transform  >Flip  پیست کنید. با رفتن به  کپی و    Color Lookup adjustmentبالای آخرین  

Horizontal  کنید.فلیپ  را تور ، لایه 

یک ماسک  و برای عروس تنظیم کنید  Free Transform (Control-T)با استفاده از اندازه و عرض را  .2

 اضافه کنید.تور   های برای اصلاح لبه  لایه ای

 

 9مرحله 

 کنیم!  تور دوم را اضافه برای جلوه  بیشتر، اجازه دهید 

 کنید.و اندازه فلیپ  ،  با عروسناسب تو آن را متخاب کرده نارا   2شماره  تور ، روش بالابا استفاده از 



 
را به لایه تور کلیپ   Hue and Saturationاز جدید تنظیم . سپس یک لایه تور جدید را روی تور اول لایه کنید 

 .کند  تا رنگ آن به سفید تغییرکنید 

 مقادیر زیر را اضافه کنید: 

 0: (Hue) رنگ •

 - 97: (Saturation) اشباع •

 0: (Lightness)  روشنایی •



 
 .تور را افزایش دهید کنتراست 

را مانند زیر   RGB، منحنی کانال تور کلیپ کنید. برای کنتراست بیشتر را به لایه Curvesیک لایه تنظیم جدید 

 تنظیم کنید.



 
 

 !به شکل زیر در آمده اند  زوج دوست داشتنی ماتا اینجا 



 
 

 Color Schemeنحوه تنظیم  -3

 را تغییر داده ایم!  مؤلفه های اصلی  تا اینجا تقریباً تمام 

(  Color Scheme)نیاز به اضافه کردن چند لایه تنظیم دیگر برای بهینه سازی طرح رنگ بنابراین در این مرحله 

 . داریم برای یک پالت بهتر

 

 1مرحله 

 با کوه شروع کنیم.اجازه دهید 

 . در لایه کوه تنظیم شود Clipping Maskبه عنوان  یک لایه جدید ایجاد کرده و راست کلیک کنید تا
های جلوی زیر چمن از یک برس نرم گرد استفاده کنید  در قسمت  184d0e# استفاده از رنگ سبز برای 

)90%-70, Opacity0%Hardness( . 

 ٪ کاهش دهید. 10را به    Opacityتنظیم کرده و  Multiplyرا روی   Layer Blend Modeحالت 



 
 .کلیپ کنید  آنیک لایه جدید دیگر بالاتر از 

 جدا کنم.از هم را چمن من سعی دارم با بازی با نور قسمت های پیش زمینه و پس زمینه 

#  b9b522رنگ سبز روشن  و  )Opacity100%Hardness ,%100( سفتاز یک برس گرد با استفاده اکنون 

 تنظیم کنید. Soft Lightرا روی    Layer Blend Modeکنید. سپس را رنگ آمیزی بخش های چمن پس زمینه  



 
 2مرحله 

 . را به لایه کوه کلیپ کنید  Adjustmentدو لایه جدید  

<  Layer  >New Adjustment Layerانتخاب کنید. سپس به     Polygonal Lasso Tool (L)کوه را با استفاده از

Gradient Map   .بروید 

و    Multiplyرا روی    Layer Blend Modeایجاد کنید. سپس    82b5a6#  سبز روشنبه    e 22847#یک شیب سبز 

Opacity   قرار دهید.70روی   را ٪ 



 
 

 ، یک لایه جدید تنظیم کنید.اکنون برای ایجاد تعادل رنگ 

 تنظیم کنید. شکل زیر را به  Highlightsو   Midtonesمقادیر  

• Midtones:55-+2, 0,     

• Highlights:77-16, -+13,   



 
 3مرحله 

 . تر کنید آسمان را کمی سفید 

برای رنگ   )Opacity0%Hardness ,10-%20(گرد یک لایه جدید را به لایه کوه بچسبانید و از یک برس نرم 

 را در صورت لزوم تنظیم کنید.لایه   Opacityآمیزی سفید روی آسمان استفاده کنید. 

 را رنگ آمیزی کنید.وه طبیعی تر لبه ها  برای ایجاد یک جل



 
 لایه ها نباید یکدیگر را قطع کنند. لایه کوه اضافه کنید.در بالای  را  Curvesیک لایه تنظیم جدید 

 برای نرم کردن شدت رنگ های فعلی لازم است.  نظیم کنید. این جلوه ظریف ،را مطابق شکل ت  RGBمنحنی کانال  

 



 کار نحوه به پایان رساندن   -4

 !نوبت دسته گل رسیده است

 

 1مرحله 

 دارند.   بیشتری این مراحل آخر به لایه های تنظیم جدید و جزئیات ظریف نیاز

 ایجاد کنید. Color Balance، یک لایه تنظیم جدید در بالای لایه های دیگر

 زیر تنظیم کنید: را به صورت  Highlightsو   Midtonesمقادیر  

• Midtones:3, +6-+14,   

• Highlights:10-19, - ,1-  

 ٪ کاهش دهید.60را به  Opacityسپس 

 
 اضافه کنید.Color Lookup  جدید تنظیمات اکنون یک لایه 

 تنظیم کنید. Strip.look33را روی  DLUT3پرونده 

 



 
 2 مرحله 

 ! ادامه می دهیم

 ضافه کنید. ا Color Balance یک لایه تنظیم جدید 

 تنظیم کنید. -1+ 0 ,50روی  مقادیر سایه ها را

 



 
 استفاده کنید.    Paint Bucket Tool (G)، از# f2adafبرای پر کردن یک لایه جدید با رنگ صورتی  

 ٪ کاهش دهید.25را   Opacityتنظیم کرده و   Hueرا روی   Layer Blend Modeحالت 



 
 3مرحله 

 !منظره رسیده است زمان ساخت 

 تنظیم کنید.  Overlayو آن را روی  ه جدید بالاتر از بقیه ایجاد کردهیک لای 

چمن   برای نقاشی برجستگی های موجود در )Opacity100%Hardness ,10-%30(از یک برس سخت گرد 

 پس زمینه منتهی به پیش زمینه استفاده کنید. 

،  . حتماً قسمت هایی از لباس عروس است از سمت چپهمانطور که مشاهده می کنید جهت نور را دنبال کنید؛ 

 رنگ آمیزی کنید.ته گل و لباس داماد را با نور  دس



 
 4مرحله 

 . می پردازیم  همچنان به وضوح صحنه

برای رنگ آمیزی نور در  گرد . از یک برس نرم برای نور و پالایش بیشتر ایجاد کنید اکنون لایه های جدیدی را 

 منتشر شود.   یقسمت بالا استفاده کنید تا نور بیشتر

تور لبه های  اطراف دامن و در برس سخت گرد دامن عروس را با رنگ سفید پر کنید و یک از با استفاده سپس 

 ایجاد کنید.واضح و شفاف 

 .را مشاهده می کنید  قبل و بعد در تصویر زیر تنظیم کنید. لایه ها را  Opacityدر صورت لزوم 



 
 5مرحله 

 مقداری فضای سبز اضافه کنید!

در تصویر زیر نشان داده شده است، یک   کنید. همانطور کهپیست را روی ترکیب خود کپی و زوج عکس اصلی 

 ماسک بزنید.  را و همه چیز به جز قسمت های پایین چمن ماسک لایه ای اضافه کرده

 .را کلیپ کنید   Levels، یک لایه تنظیم جدید تسپس برای بهبود کنتراس



 
 

 6مرحله 

داشته باشید. این کار را با یک برس سخت گرد و رنگ   بیشتریممکن است نیاز به چمن  کردن منظرهبرای تراز 

 .ترسیم کنید  انجام دهید. خطوط کوتاه و صاف #f9f9daزرد روشن  

  Opacity چمن با لایه های ظریف رنگ ادامه دهید. با یک برس سخت نرم و با در صورت لزوم به تراز کردن 

 رنگ برای انتخاب    Eyedropper Tool (E)( به طور مستقیم روی این مناطق نقاشی کنید و از  51-٪5بسیار کم ) 

 کنید.  بعنوان مرجع استفادههای اطراف 

یک رنگ سبز نرم و در قسمت زیر پای آنها از فراموش نکنید که سایه ظریفی در زیر عروس و داماد اضافه کنید! 

 .استفاده کنید تیره 



 
 7مرحله 

 . بالاتر ببرید   Levelجدید یک لایه تنظیم استفاده از  اکنون وضوح را با 

 ، زرد و سبز پیش تنظیم صورتیروی  را    گرادیان  جدید نقشه گرادیان به پایان برسانید.  با یک لایه تنظیمکار خود را  

 قرار دهید.

 ٪ تغییر دهید. 17به  Opacityو  Colorرا به   Layer Blend Modeسپس 



 



 متن و جلوه های ویژه   نحوه اضافه کردن -5

 متن اضافه کنید!برای ایجاد یک جلوه خاص تر، یک  

 

 1مرحله 

 استفاده کردم.  Salbatora Scriptقلم   ازدر اینجا من 

 

 
 2مرحله 

امتحان کنید.   Elements Envatoاز را  Action Photoshop Shimmerیک ، رای یک نسخه جایگزین زیباب

 . اکشن را دانلود و اجرا کنید و از آن لذت ببرید  و سپس ذخیره کرده   jpegابتدا نتیجه نهایی را به عنوان 

https://elements.envato.com/shimmer-photoshop-action-QP7N77?_ga=2.155145147.2012608676.1569693965-51521731.1565809847
https://elements.envato.com/?_ga=2.198603308.2012608676.1569693965-51521731.1565809847


 



 !نتیجه نهایی را در زیر مشاهده کنید 



 


